9936 LogWare III
User’s Guide
WARRANTY
Hart Scientific, Inc. (Hart) warrants this product to be free from defects in material and workmanship under normal use and service for a period as stated in our current product catalog from the date of shipment. This warranty extends only to the original purchaser and shall not apply to any product that, in Hart’s sole opinion, has been subject to misuse, alteration, abuse or abnormal conditions of operation or handling.
Software is warranted to operate in accordance with its programmed instructions on appropriate Hart products. It is not warranted to be error free. Hart’s obligation under this warranty is limited to repair or replacement of a product that is returned to Hart within the warranty period and is determined, upon examination by Hart, to be defective. If Hart determines that the defect or malfunction has been caused by misuse, alteration, abuse or abnormal conditions or operation or handling, Hart will repair the product and bill the purchaser for the reasonable cost of repair. To exercise this warranty, the purchaser must forward the product after calling or writing Hart for authorization. Hart assumes NO risk for in-transit damage.
For service or assistance, please contact the manufacturer.

Hart Scientific, Inc.
799 East Utah Valley Drive
American Fork, UT 84003-9775
Phone: (801) 763-1600
Fax: (801) 763-1010
E-mail: support@hartscientific.com

THE FOREGOING WARRANTY IS PURCHASER’S SOLE AND EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE OR USE. HART SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOSS WHETHER IN CONTRACT, TORT, OR OTHERWISE. Microsoft®, MS-DOS®, Windows®, Windows for Workgroups®, Windows® 95, Windows® 98, Windows® ME, Windows® NT, Windows® 2000 and Windows® XP are registered trademarks or trademarks of Microsoft Corporation.

Copyright © 2003 All Rights Reserved
Hart Scientific, Inc.
799 East Utah Valley Drive
American Fork, UT 84003-9775
Phone: (801) 763-1600 · Fax: (801) 763-1010
E-mail: support@hartscientific.com
Table of Contents

1 Introduction ................................................................. 1
  1.1 Symbols Used .......................................................... 1
  1.2 Conventions ............................................................ 1
  1.3 What is LogWare ........................................................ 2
  1.4 Features ............................................................... 2
  1.5 Requirements .......................................................... 4
    1.5.1 Communications Requirements .................................... 4
    1.5.2 Computer Requirements ........................................... 4
  1.6 Installation ............................................................ 5
  1.7 Running LogWare ...................................................... 6
    1.7.1 Getting Started ..................................................... 6
    1.7.2 LogWare Main Display ............................................ 9
    1.7.3 Menus ................................................................. 11
      1.7.3.1 File Menu ..................................................... 11
      1.7.3.2 Datalog Menu .................................................. 12
      1.7.3.3 View Menu .................................................... 13
      1.7.3.4 Graph Menu ................................................... 13
      1.7.3.5 Tools Menu .................................................... 14
      1.7.3.6 Window Menu ................................................... 15
      1.7.3.7 Help Menu ..................................................... 15
    1.7.4 Options ............................................................ 15

2 Security Features ....................................................... 17
  2.1 Administration ....................................................... 17
  2.2 User Accounts ........................................................ 18
    2.2.1 Creating and Managing User Accounts ............................. 19
      2.2.1.1 Create New User Account ..................................... 19
      2.2.1.2 Modify Existing Account ..................................... 20
      2.2.1.3 Remove Existing Account ..................................... 21
      2.2.1.4 Access Levels ................................................ 21
      2.2.1.5 User Names and Passwords ................................... 22
      2.2.1.6 Setting and Changing Account Passwords .................. 22
        2.2.1.6.1 Setting Account Passwords ............................... 22
        2.2.1.6.2 Changing Account Passwords ............................. 23
        2.2.1.6.3 Creating Accounts without a Password ................. 26
    2.2.3 Managing Locations .............................................. 30
      2.2.3.1 Adding a New Location .................................... 31
      2.2.3.2 Removing an Existing Location ............................ 31

3 LogWare III Options ...................................................... 33
Figures

Figure 1  Main Display ........................................... 9
Figure 2  Database Login ......................................... 18
Figure 3  Manage User Accounts .................................. 19
Figure 4  Change Password ....................................... 23
Figure 5  Manage User Accounts ................................... 24
Figure 6  Database Login ......................................... 25
Figure 7  Change Password ....................................... 26
Figure 8  Manage Equipment .................................... 27
Figure 9  Manage Equipment - Loggers Tab ...................... 28
Figure 10  Manage Equipment - Sensors Tab .................... 29
Figure 11  Manage Equipment - Locations Tab ................. 30
Figure 12  LogWare III Options .................................. 33
Figure 13  LogWare III Options - General Tab ................. 34
Figure 14  LogWare III Options - Folders Tab ................. 35
Figure 15  LogWare III Options - Communications Tab ........ 36
Figure 16  RS-232 Communication Settings ..................... 37
Figure 17  LogWare III Options - Real-Time Tab .............. 38
Figure 18  LogWare III Options - Graph Tab ................... 40
Figure 19  Color Selection ...................................... 41
Figure 20  Trace Colors .......................................... 42
Figure 21  Real-Time Log Session Settings ..................... 44
Figure 22  Real-Time Log Session Settings - Logger Tab .... 45
Figure 23  Real-Time Log Session Settings - Session Tab ... 48
Figure 24  Alarm Settings ....................................... 50
Figure 25  Statistics Settings - General Tab ................... 52
Figure 26  Statistics Settings .................................... 52
Figure 27  Statistics Settings - Sliding Window Tab .......... 53
Figure 28  Color Selection ...................................... 53
Figure 29  Real-Time Log Session ............................... 54
Figure 30  Select Delayed Start Date/Time ...................... 55
Figure 31  Select Graph To Print .................................. 56
Figure 32  Import Options ....................................... 59
Figure 33  Imported Data ........................................ 61
Figure 34  Download Options ..................................... 64
Figure 35  View Logged Data Options ......................... 67
Figure 36  View Logged Data Options - Criteria Tab ........ 68
Figure 37  View Logged Data Options - Misc. Settings Tab ... 69
Figure 38  Logged Data .......................................... 70
Figure 39  Select Graph To Print .................................. 71
Figure 40  Add Annotation ....................................... 73
Figure 41  Edit Annotation ....................................... 74
1 Introduction

1.1 Symbols Used

Table 1 lists the symbols that are used throughout this User Guide and their meanings.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>This symbol indicates you must be logged into the LogWare database as an administrator to perform the task.</td>
</tr>
<tr>
<td>1</td>
<td>This symbol indicates you must be logged into the LogWare database with an access level of 1 or higher to perform the task.</td>
</tr>
<tr>
<td>2</td>
<td>This symbol indicates you must be logged into the LogWare database with an access level of 2 or higher to perform the task.</td>
</tr>
<tr>
<td>3</td>
<td>This symbol indicates you must be logged into the LogWare database with an access level of 3 to perform the task.</td>
</tr>
<tr>
<td>i</td>
<td>This symbol indicates important information.</td>
</tr>
<tr>
<td>!</td>
<td>This symbol indicates cautions or warnings.</td>
</tr>
</tbody>
</table>

1.2 Conventions

The following conventions are used throughout this User Guide.

<table>
<thead>
<tr>
<th>Temperature scale</th>
<th>Italicics denote menu names, menu options, and field names on dialogs and windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-Time Log Session Settings</td>
<td>Dialog and window titles are capitalized</td>
</tr>
<tr>
<td>File</td>
<td>Print</td>
</tr>
<tr>
<td>Play .WAV file</td>
<td>Bold type denotes selectable options</td>
</tr>
<tr>
<td>&lt;unknown format&gt;</td>
<td>Angle brackets '&lt;&gt;' denote special markers</td>
</tr>
</tbody>
</table>
1.3 What is LogWare

LogWare is a Windows® application that retrieves, stores, and analyzes data from the Hart Scientific Model 1620 “DewK” Thermo-Hygrometer.

LogWare can import data batches from PC cards or download data directly from the DewK’s memory. In addition, LogWare can log data in real time via an RS-232 cable. Real-time data may be logged from one or both of a DewK’s sensors, providing up to two temperature and two humidity inputs.

All data is stored in a single database and is easily retrievable based on date and time ranges and sensor names (which can be modified to indicate locations). Configurable user accounts and access levels can ensure appropriate security and integrity of all stored data.

Real-time data may be viewed in customizable graphic and statistical formats. Graphs can be displayed for both temperature and humidity for one or both sensor inputs in user-selectable time-increments. A variety of critical statistical functions can also be shown for each input, including min, max, average, and standard deviation. Alarm settings accompany imported, downloaded or real-time data and can be highlighted in the graphs and displayed statistics. Alarm events can also be triggered from the software while logging data in real-time.

LogWare allows onscreen viewing of logged data. It also prints reports and exports data easily to multiple file formats that can be viewed in Excel or other common spreadsheet and database programs.

1.4 Features

LogWare’s data logging features include:

- Quick and easy configuration
- Ability to save and open configuration files
- Selectable sample interval from 1 second to 24 hours
- Selectable delayed start date/time for off-hours real-time logging
- Selectable end log options (to stop session after specified time or number of readings)
- Logs all readings to database
- Graphs readings and calculates statistics as they are being logged
- Selectable high and low alarm settings with user defined events (Can be configured to play .WAV file or launch an application, such as pager software, when an alarm trips)
• User-customizable graph settings
• Graph temperature and humidity on same graph or on separate graphs

LogWare’s data analysis features include:
• Select data to display based on location or sensor and date/time range
• Spreadsheet-style grid to view all logged readings
• Graph zooming capability
• Statistical calculations
• Printing graphs and reports
• Export logged data to various file types
• Annotations can be appended to any reading
• Checksum calculations identify data that has been potentially tampered with
• Can have multiple windows open simultaneously

LogWare’s security features include:
• Built-in administrator account for performing administrative functions
• User accounts for individual users or teams
• Selectable access level for each user account to restrict access to software features
• User name and password required for login to database
• Activate/Deactivate individual user accounts to allow/prevent login
• Activate/Deactivate individual loggers, sensors, and locations to allow/prevent use

LogWare also provides additional utilities for:
• Downloading data from the logger’s memory via RS-232
• Importing data from files written by the logger to a PC card
• Viewing data stored in the database
• Exporting data to multiple file types
• Printing reports and graphs
• Appending annotations to data points

1.5 Requirements

LogWare is designed to work with the Hart Scientific Model 1620 “DewK” Thermo-Hygrometer (logger).

1.5.1 Communications Requirements

To perform real-time logging or to download data from the logger’s memory, the logger must be connected to an RS-232 serial port (COM port) on a computer using a “null modem” cable. For more information on this type of cable, refer to the logger’s User’s Guide. When using serial (RS-232) communications, LogWare is designed to auto-detect the baud rate that the logger is operating at. For best results, set the logger to use a fast baud rate (9600 baud or higher).

If there is no COM port available on the computer but the computer has a USB port, you may be able to use a USB to RS-232 adapter such as the IOGEAR Model G-UC232A USB PDA/Serial Adapter. Not all USB to RS-232 adapters may work. The adapter mentioned above has been tested and determined to work properly.

LogWare does not currently support communicating with the logger using the IR port.

1.5.2 Computer Requirements

The following minimum computer configuration is required to install and use LogWare:

• IBM Compatible Pentium PC or better with minimum 32MB RAM
• VGA monitor or better
• CD-ROM drive for installation
• 1 - RS-232 serial (COM) port
• Minimum of about 35MB of disk space for installation - Additional disk space required to store data

In addition, LogWare requires one of the following operating systems:

• Windows® 98 Second Edition
• Windows® ME
• Windows® NT (Service Pack 6 or later recommended). Windows® NT requires Internet Explorer v5 or later be installed prior to installing LogWare.

• Windows® 2000

• Windows® XP

1.6 Installation

A backup should always be made of your hard disk drive and registry before installing any software and all running applications should be closed. If LogWare is currently installed on the computer, follow the Repairing or Removing LogWare instructions below.

**Note:** When installing LogWare on a computer that is running Windows® NT/2000/XP, you must log on with Administrator rights to successfully complete the installation.

**Installing LogWare**

1. Insert the LogWare CD-ROM into your CD-ROM drive. The Setup program should run automatically.

2. Follow the on-screen instructions to install LogWare.

3. Read the installation notes file that is displayed for important information regarding known installation issues.

4. When prompted, enter the product serial number. The serial number is provided on a sticker typically located on the CD pouch on the inside back cover of the LogWare User’s Guide. The serial number should follow the format: XXXXXX-XXXXXX-XXXXXX

5. The software files are copied to the specified folder and icons are created in the Programs menu.

6. Read the ReadMe file that is displayed after installation is complete for important information that was not available when the User Guide was printed and other important information.

7. When the installation is finished, the computer will need to be restarted. Allow the computer to restart.

**Note:** When restarting the computer, login once more with Administrator rights so that the installation may complete. You may login to Windows® normally on subsequent logins.
Repairing or Removing LogWare

If LogWare is currently installed on the computer, it can be repaired or removed using the Add/Remove Programs utility in the Control Panel. To repair or remove LogWare, follow the instructions below:

**Note:** When repairing or removing LogWare on a computer that is running Windows® NT/2000/XP, you must log on with Administrator rights.

1. Open the Control Panel by selecting the *Settings | Control Panel* option in the *Start* menu.
2. In the Control Panel, double-click the *Add/Remove Programs* icon to open the Add/Remove Programs dialog.
3. In the list that appears, locate and click on the LogWare III entry.
4. Click the *Add/Remove* (Windows® 98/NT) or *Change/Remove* (Windows® 2000/XP) button.
5. Follow the on-screen instructions to repair or remove the software.
6. When finished repairing or removing the software, close the Add/Remove Programs dialog by clicking the *OK* (Windows® 98/NT) or *Close* (Windows® 2000/XP) button.

**Info:** Removing this software does NOT delete the database files, any user-created files including export, import, or configuration files. These files must be removed manually using Windows® Explorer. You may receive one or more prompts to choose whether or not to remove a specific file from the system as the software is being removed. Be careful not to remove a file that is required by another application. To be safe, you may wish to choose NOT to remove all of these files. If you are sure the files are not used by any other applications, they may be removed.

### 1.7 Running LogWare

The following sections describe how to get LogWare up and running quickly.

### 1.7.1 Getting Started

The following information is intended to provide a brief overview on how to get LogWare up and running quickly.
Running LogWare

1 Click or double-click the LogWare III icon to run LogWare. An icon was placed on the desktop during installation, or locate the icon in the Programs option in the Start menu.

2 The software will start and display the Database Login dialog. Login to LogWare using the built-in administrator account to create user accounts. Refer to Section 2.1, Administration, for more information on the built-in administrator account.

3 Once logged in, select the Manage User Accounts option from the Tools menu to create one or more user accounts. Assign each user account an appropriate access level. Passwords are created the first time an account is used to login to the database. Refer to Section 2.2, User Accounts, for more information on user accounts, passwords, and access levels.

Info: For maximum security, check the Change password on next login option on the LogWare administrator account to change the password for the built-in administrator account on next login.

4 Click OK to close the Manage User Accounts dialog and exit LogWare.

5 Run LogWare again and login using a newly created user account. Leave the Password field blank when logging in using an account for the first time. The Change Password dialog is displayed. Enter a password for this user account and click OK to continue. On subsequent logins, both the user name and password must be entered.

Note: Be sure not to forget your passwords! They cannot be recovered, even by the administrator! Write down your passwords and keep them in a secure place.

6 When LogWare runs, the Real-Time Log Session Settings dialog is displayed. Use this dialog to configure a real-time log session. To prevent this window from being displayed automatically on startup, refer to Section 3, LogWare III Options.

7 To start a real-time log session, connect the logger to a serial port on the computer (LogWare defaults to COM1 - use LogWare III Options dialog to change this setting). Click the Query Logger button. LogWare reads in the current logger and sensor model numbers, serial numbers, alarm settings, etc. and fills in the information on the Logger tab. You may change this information as required.

8 Click the Session tab. Select the logging interval and start and end criteria.
Click the *Start* button to start logging data in real-time.

Log session settings can be saved to a configuration file by clicking the *Save As* button on the Real-Time Log Session Settings dialog prior to starting the log session. Refer to Section 3, *LogWare III Options*, for options on loading a configuration file and starting a log session automatically when *LogWare* starts.
1.7.2 LogWare Main Display

The main display consists of the menus, toolbar, a workspace area and a status bar.

Figure 1  Main Display

The menus allow access to the various features of the software. A general description each menu is given below:

- **File** - Create a new real-time log session, import and export data, print reports and graphs, login as new user and exit LogWare

- **Datalog** - Create a new real-time log session, stop and close real-time log sessions, mute alarms

- **View** - Show/hide toolbar and status bar, view logged data in the database

- **Graph** - Show alarms, data points and annotations on the graphs, zooming and printing graphs

- **Tools** - Download data from a logger, manage equipment and user accounts, database tools, change LogWare options

- **Window** - Rearrange and switch between open windows
The toolbar allows quick access to the most common menu functions. The toolbar is divided into sections that correspond to related functions. Toolbar sections may be rearranged as desired by clicking on the vertical bar on the left side of the section and dragging it to the desired location. The following toolbars are available:

**File Toolbar**

- **New** - Create a new real-time log session
- **Import** - Import data from record files into the database
- **Export** - Export data from the database
- **Print** - Print reports and graphs

**Datalog Toolbar**

- **Setup** - Create a new real-time log session
- **Stop** - Abort a real-time log session

- **Close** - Close a real-time log session window
- **Mute All Alarms** - Prevents alarm events from occurring
Graph Toolbar

- **Show Alarms** - Shows horizontal alarm lines on the graphs
- **Show Data Points** - Shows markers at data points on the graphs
- **Show Annotations** - Shows annotations on the graphs
- **Undo Zoom** - Restores the graphs to show all data

Tools Toolbar

- **Download** - Download data into the database
- **Manage Equipment** - Manage loggers, sensors, and locations
- **Manage User Accounts** - Manage user accounts and access levels
- **LogWare Options** - Change LogWare’s default settings

Help Toolbar

- **Help** - Opens the on-line help file

The status bar indicates the function that the software is currently performing as well as the current system date and time.

**Info:** The date and time displayed are based on the computer’s clock settings and can be modified through the Windows® Control Panel.

1.7.3 Menus

The following sections briefly outline each of LogWare’s menus and menu options.

1.7.3.1 File Menu

The *File* menu contains the following options:

- **New Log Session** - Creates a new real-time log session; Refer to Section 4, Real-Time Data Logging
1.7.3.2 Datalog Menu

The **Datalog** menu contains the following options:

- **Setup** - Creates a new real-time log session; Refer to Section 4, Real-Time Data Logging
- **Stop** - Aborts a real-time log session; Refer to Section 4, Real-Time Data Logging
- **Close** - Closes a real-time log session window; Refer to Section 4, Real-Time Data Logging
- **Mute All Alarms** - Prevents real-time log session alarm events from occurring
1.7.3.3 View Menu

The View menu contains the following options:

- **Toolbar** - Shows/hides the toolbar buttons
- **Status Bar** - Shows/hides the status bar at the bottom of the main display
- **Logged Data** - Displays logged data; Refer to Section 7.1, Viewing Logged Data

1.7.3.4 Graph Menu

The Graph menu contains the following options:

- **Show Alarms** - Shows/hides horizontal alarm lines on the graphs
- **Show Annotations** - Shows/hides vertical annotation lines on the graphs
- **Show Data Points** - Shows/hides data point markers on the graphs
- **Undo Zoom** - Restores the graphs to their normal state
- **Print Graph** - Prints the graphs in the active window
1.7.3.5 Tools Menu

The Tools menu contains the following options:

- **Download** - Downloads data from the logger’s memory; Refer to Section 6, Downloading Data

- **Manage Equipment** - Manages loggers, sensors, and locations; Refer to Section 2.3, Managing Equipment

- **Manage User Accounts** - Manage user accounts; Refer to Section 2.2, User Accounts

- **Database** - Provides options for maintaining the database.
  - **Compact Database** - Compacts the LogWare database; Refer to Section 8, Database Maintenance

- **Annotations** - Provides options for managing annotations.
  - **Add** - Adds an annotation to a data record; Refer to Section 7.1.3, Annotations
  - **Edit** - Edits an annotation of a data record; Refer to Section 7.1.3, Annotations
  - **Remove** - Removes an annotation from a data record; Refer to Section 7.1.3, Annotations

- **Options** - Allows access to LogWare’s default options and settings; Refer to Section 3, LogWare III Options
1.7.3.6 Window Menu

The Window menu contains the following options:

- **Cascade** - Cascades all open windows
- **Tile Horizontal** - Tiles all open windows horizontally
- **Tile Vertical** - Tiles all open windows vertically
- **Arrange Icons** - Arranges the icons for all minimized windows at the bottom of the main display
- **Window List** - Displays a list of all open windows

1.7.3.7 Help Menu

The Help menu contains the following options:

- **Contents** - Opens the on-line help file to the Contents topic
- **Technical Support** - Opens the on-line help file to the Technical Support topic
- **About** - Displays the About dialog

1.7.4 Options

LogWare has many features and settings that can be customized by the user to allow LogWare to operate in certain ways. For more information on these options, please refer to Section 3, LogWare III Options.
2 Security Features

LogWare provides security features that allow an administrator to control which users have access to certain software functions and features. Access to these features is controlled by requiring login using a user name and password. The following sections outline how to create and manage administrator and user accounts and passwords to control access to LogWare’s features.

2.1 Administration

When LogWare is installed on a computer for the first time, an administrator account is created. You must use this account to login to LogWare to create and manage user accounts. You may also setup additional administrator accounts. The login user name and password for the default administrator account are:

User name: LogWare
Password: LogWare

Note: You should change the password for the default administrator account to prevent unauthorized user access. Passwords are case-sensitive! Refer to Section 2.2.1.6.2, Changing Account Passwords, for more details on changing account passwords.
Every time LogWare runs, the Database Login dialog is displayed. Enter the default administrator user name and password as indicated above and click OK.

![Database Login](image)

**Figure 2 Database Login**

When logged in using an administrator account, access to most of LogWare’s features is restricted. Administrators cannot open real-time log sessions, import or download data, view, export, or print logged data, or use any of LogWare’s other data-related functions. Administrators are only allowed to change LogWare’s default settings, manage loggers, sensors, locations, and user accounts.

Select the *Manage User Accounts* option in the *Tools* menu to create and manage user accounts.

### 2.2 User Accounts

LogWare has some security features that allow an administrator to secure and control access to and use of certain functions. One of these features is user accounts.

User accounts allow LogWare to identify users who perform certain tasks. They also allow the administrator to determine permissions (which users have access to certain features). Each user account consists of a user name, password, first name, last name and access level.

By default, LogWare has one built-in administrator account. After LogWare is installed, the administrator must use this account to login and create accounts.
for each person who is to use the software. Also, the administrator should change the password for the built-in administrator account to prevent unauthorized access to the software.

⚠️ **Note:** Do not forget your passwords! They cannot be recovered, even by the administrator! If necessary, write them down and keep them in a secure location.

### 2.2.1 Creating and Managing User Accounts

To create and manage user accounts, you must login using an administrator account. Select the *Manage User Accounts* option in the *Tools* menu to display the Manage User Accounts dialog.

![Manage User Accounts](image)

*Figure 3 Manage User Accounts*

The *Users* list displays the current user and administrator accounts. To view an account’s settings, click on the account in the list. The account settings are displayed in the fields to the right of the list.

#### 2.2.1.1 Create New User Account

To create a new user or administrator account:

1. Click the *New* button. A new account is created with a generic user name.
2. Change the user name to the desired name.

3. The *Active* option is checked by default, indicating that this account may be used to login. If you wish to make this account inactive, uncheck this option.

4. **Optional** - Fill in the *First name* and *Last name* fields. These fields may be left blank if desired.

5. Assign an access level to this account using the *Access level* drop-down list. To make this account an administrator account, assign an access level of 4 (Administer only). Otherwise, select the access level that you wish for this user to have based on the functions they are to perform. Refer to Section 2.2.1.4, Access Levels, for more details on access levels.

6. You may add any remarks for this account to the *Remarks* field. By default, information about the creation of the account is placed here.

7. The *Change password on next login* option indicates whether this user must change the password the next time they login using this account. For new accounts, leave this option checked to require a password for this account.

**Note:** For new accounts, leaving this option unchecked will allow the user to login without a password! This feature may be useful for creating a generic user account with view only access (access level 0). However, for reasons of security, it is not recommended to create user accounts with an access level higher than 0 that do not require a password!

### 2.2.1.2 Modify Existing Account

To modify the current settings of an existing account:

1. Select the account in the *Users* list.

2. To activate or deactivate this account (allow/prevent this account to be used to login), check or uncheck the *Active* option.

3. To change the user’s first or last name, enter the new values in the *First name* and *Last name* fields.

4. To change this user’s access level, select the new access level using the *Access level* drop-down list.

5. To require this user to create a new password on next login, check the *Change password on next login* option.
Note: The user name of existing accounts cannot be changed! If you wish to change a user name, deactivate or remove the account and create a new account with the new user name. The built-in administrator account, LogWare, cannot be modified! The password for this account, however, can and should be changed.

2.2.1.3 Remove Existing Account

To remove an existing account:
1. Select the account in the Users list.
2. Click the Remove button. A prompt is displayed to confirm removing the account. Click Yes to remove the account.

Note: A user account should only be removed if it is never to be used again. If you wish to temporarily disable an account, simply uncheck the Active option. The built-in administrator account, LogWare, cannot be removed!

2.2.1.4 Access Levels

LogWare allows each user account to be assigned an access level. The access level indicates which functions of LogWare a user is allowed to use. Each access level is described below.

<table>
<thead>
<tr>
<th>LogWare Functions/Features</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>View logged data</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Print reports and graphs</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Export logged data</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Real-time logging</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Import data from files</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Download data from logger</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Change LogWare’s default settings</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Add annotations to logged data</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Modify annotations to logged data</td>
<td>-</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Remove annotations from logged data</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Create and manage user accounts</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>Manage loggers, sensors, and locations</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>X</td>
</tr>
</tbody>
</table>
2.2.1.5 User Names and Passwords

LogWare imposes some simple rules about user names and passwords that must be observed.

User names:

- are not case-sensitive
- must be unique
- must be between 4 and 20 characters in length
- can consist of numbers, letters, and any of the following symbols: - + . @ ! # $ % & ^ _ | ~

Passwords:

- are case-sensitive
- must be between 4 and 20 characters in length
- can consist of numbers, letters, and any of the following symbols: - + . @ ! # $ % & ^ _ | ~

Info: Currently, LogWare does not impose any restrictions regarding complexity, minimum or maximum age, or re-use of passwords.

2.2.1.6 Setting and Changing Account Passwords

Each user account can have a password. Passwords are set and changed when a user logs in. Optionally, one or more accounts can be configured to not require a password. This feature may be useful for allowing a person or group of people to login with an access level of 0 (view only).

Note: Do not forget your passwords! They cannot be recovered, even by the administrator! If necessary, write them down and keep them in a secure location.

2.2.1.6.1 Setting Account Passwords

To set the password for a new account:

1. Create the user account. Make sure the Change password on next login option is checked.
2. Click OK to close the Manage User Accounts dialog.
3. Close LogWare.
4 Run LogWare.

5 On the Database Login dialog, enter the user name for the account. Leave the Password field blank. Click OK.

6 The Change Password dialog is displayed. Enter the new password in the New password and Confirm password fields and click OK. The password is now set.

![Change Password](image)

**Figure 4 Change Password**

### 2.2.1.6.2 Changing Account Passwords

To change the password for an existing account:

1 Run LogWare and login using an administrator account.
2 Select the *Manage User Accounts* option from the *Tools* menu. The Manage User Accounts dialog is displayed.

3 In the *Users* list, select the account.

4 Check the *Change password on next login* option.

5 Repeat for other accounts as needed.

6 Click *OK* to close the Manage User Accounts dialog.

7 Select the *Login as New User* option from the *File* menu.
8  On the Database Login dialog, enter the user name and current password for the account and click OK.

![Database Login]

Figure 6  Database Login

9  The Change Password dialog is displayed. Enter the new password in
the New password and Confirm password fields and click OK. The password is now changed.

![Change Password](image)

**Figure 7** Change Password

### 2.2.1.6.3 Creating Accounts without a Password

To setup an account to not require a password:

1. Create a new user account. Make sure the *Change password on next login* option is NOT checked.
2. Click OK to close the Manage User Accounts dialog.
3. Close LogWare.
4. Run LogWare.
5. On the Database Login dialog, enter the user name for the account. Leave the Password field blank. Click OK.

**Info:** Once a password has been assigned to an account, it is not possible to remove the password from that account. The password may be changed, but it cannot be removed. You must create a new account without a password.
Note: Although LogWare allows for any account to be created without requiring a password, it is not recommended to do so for security reasons.

2.3 Managing Equipment

Whenever data gets logged to the database, whether in real-time, by importing, or by downloading, LogWare records the logger model and serial number, sensor model and serial number, and the location. This information is always associated with the data.

LogWare administrators can manage the loggers, sensors, and locations using the Manage Equipment feature. To access this feature, login as an administrator, then select the Manage Equipment option in the Tools menu. The Manage Equipment dialog is displayed.

![Manage Equipment dialog](image)

Figure 8 Manage Equipment

The Manage Equipment dialog has three tabs: Loggers, Sensors, and Locations.
2.3.1 Managing Loggers

The Loggers tab includes a list of all loggers that have been used to log data into the database.

Loggers are automatically added to this list the first time they are used to log data in real-time, or the first time data is imported or downloaded from a logger. The model, serial number, active state, and remarks are shown for the logger that is currently selected in the Loggers list. By default, when a logger is added, it is marked as active. The Model and Serial number fields are not editable. The Remarks field defaults to the date, time, and user who first used the logger to log data to the database. The remarks information can be changed as desired.

Administrators can prevent a logger from being used to log real-time data and prevent data from a logger from being imported or downloaded into the database by simply unchecking the Active option.
2.3.2 Managing Sensors

The Sensors tab includes a list of all sensors that have been used to log data into the database.

![Figure 10 Manage Equipment - Sensors Tab](image)

Sensors are automatically added to this list the first time they are used to log data in real-time, or the first time data from a sensor is imported or downloaded. The model, serial number, active state, and remarks are shown for the sensor that is currently selected in the Sensors list. By default, when a sensor is added, it is marked as active. The Model and Serial number fields are not editable. The Remarks field defaults to the date, time, and user who first used the sensor to log data to the database. The remarks information can be changed as desired.

Administrators can prevent a sensor from being used to log real-time data and prevent data from a sensor from being imported or downloaded into the database by simply unchecking the Active option.
## 2.3.3 Managing Locations

The *Locations* tab includes a list of all locations that have been used to log data into the database.

![Figure 11 Manage Equipment - Locations Tab](image)

Locations are automatically added to this list the first time they are used to log data in real-time, or the first time data from a location is imported or downloaded. The location name, active state, and remarks are shown for the location that is currently selected in the *Locations* list. By default, when a location is added, it is marked as active. The *Location name* field is not editable. The *Remarks* field defaults to the date, time, and user who first used the location to log data to the database. The remarks information can be changed as desired.

Administrators can prevent a location from being used to log real-time data and prevent data from a location from being imported or downloaded into the database by simply unchecking the *Active* option.

New locations can be added at any time by an administrator or by any user with an access level of 1 or higher when configuring a real-time log session. Refer to Section 2.3.3.1, Adding a New Location, for more information on adding locations to the database.

Location names can be up to 16 characters long, and can consist of numbers, letters, and/or any of the following characters: - + . @ ! # $ % & ^ _ | ~
2.3.3.1 Adding a New Location

To add a new location...

1 Click the New button. A new location is created with a generic location name.
2 Change the location name to the desired name.
3 The Active option is checked by default, indicating that this location may be used to log data to the database. If you wish to make this location inactive, uncheck this option.
4 You may add any remarks for this account to the Remarks field. By default, information about the creation of the location is placed here.

2.3.3.2 Removing an Existing Location

To remove an existing location...

1 Select the location to remove from the Locations list.
2 Click the Remove button. A prompt is displayed to confirm removing the location. Click Yes to remove the location.
3 LogWare III Options

The LogWare III Options dialog allows various default settings to be selected.

The settings are divided into five tabs: General, Folders, Communications, Real-Time, and Graph.
3.1 General

The General tab displays options pertaining to the behavior of LogWare in general.

The Show Log Session Settings dialog option determines whether LogWare should automatically display the Real-Time Log Session Settings dialog every time LogWare starts up. If not checked, the other options on this tab are not applicable and are disabled.

The Open default configuration file option determines whether LogWare should automatically open the specified real-time log session settings file every time LogWare starts up. This option is useful to reduce the amount of time necessary to configure a real-time log session. When this option is checked, the configuration file to open must be specified in the Default configuration file field.

Info: When the Open default configuration file option is selected, LogWare expects that the logger is running and connected to the computer according to the settings found on the Communications tab so that it can communicate with the logger.
The **Automatically start log session** option determines whether LogWare should automatically start a real-time log session without any user interaction required.

The **Default configuration file** field indicates the configuration file that will be opened automatically every time LogWare starts up. The configuration file will only be opened if the **Show Log Session Settings dialog** and **Open default configuration file** options are both checked. Click the ... (Browse) button to locate the configuration file to be used as the default configuration file.

### 3.2 Folders

The **Folders** tab displays options pertaining to the default folders to which LogWare expects to find various types of files.

The **Default folder for configuration files** field determines the default folder to which configuration files are found. LogWare allows many types of configuration files to be saved including real-time log session settings (.LSS file) and alarm settings (.ALM file). Click the ... (Browse) button to select an existing folder.
The **Default folder for exporting files** field determines the default folder to which LogWare will export files. Click the ... (Browse) button to select an existing folder.

### 3.3 Communications

The **Communications** tab displays options pertaining to the methods of communication that LogWare supports.

The **Communications** list indicates the methods of communication that LogWare supports for communicating with loggers. This tab is not displayed if a real-time log session is running.

Only one method in this list may be checked in the **Communications** list. Currently, LogWare only supports communicating with loggers using serial (RS-232) communications.

Click the **Properties** button to view and change settings related to the highlighted method of communications.
3.3.1 **Serial (RS-232) Properties**

The RS-232 Communication Settings dialog displays the settings for the Serial (RS-232) method of communication.

![RS-232 Communication Settings](image)

**Figure 16** RS-232 Communication Settings

The *COM port* field indicates which COM port on the computer should be used for communicating with a logger. This list contains only COM ports which are currently active and available on the computer at the time this dialog was displayed. Use the drop-down list to select the COM port to use.

The *Baud rate* field indicates the default baud rate to use to communicate with a logger. Use the drop-down list to select the default baud rate to use.

**Info:** *LogWare is designed to automatically determine the baud rate that a logger is operating at. Therefore, changing this setting will not affect LogWare.*
### 3.4 Real-Time

The *Real-Time* tab displays options that are applicable only to performing real-time log sessions.

![Real-Time Tab](image)

**Figure 17 LogWare III Options - Real-Time Tab**

**Note:** Changing any of these settings only affects real-time log sessions started after closing the *LogWare III Options* dialog! Real-time log sessions that are already running are not affected.

The *Plot temperature and humidity readings on same graph* option determines whether separate graphs are created in the Real-Time Log Session window for temperature and humidity readings, or whether temperature and humidity readings are plotted on the same graph. When plotting temperature and humidity readings on the same graph, temperature readings use the left y-axis and humidity readings use the right y-axis of the graph.

The *Prompt to manually synchronize log session* option determines whether *LogWare* displays a message that the user must respond to before starting a
real-time log session. This feature may be useful when you are trying to syn-
chronize LogWare’s real-time log session with some other external process.

**Note:** Do not use the Prompt to manually synchronize log session option in
correlation with the delayed start date/time option when setting up a
real-time log session! Otherwise, your log session may not start as ex-
pected! LogWare checks for this conflict before starting a real-time log
session.

The *Sample all sensors simultaneously* option determines whether LogWare
should attempt to read all enabled sensors at the same time, or whether readings
should be taken from each sensor sequentially.

The *Show alarm settings in statistics window* option determines whether the
sensor alarm settings, if any, should be included in the real-time log session
window’s statistics list.

The *Reading resolutions* settings determine the number of decimal places to
use when logging temperature and humidity readings. LogWare sends com-
mands to the logger to configure it to use these settings when a real-time log
session starts. Select the number of digits to use for temperature readings using
the *Temperature* field and humidity readings using the *Humidity* field.

The *Real-time graph settings* option determines the amount of time (x-axis) the
graphs in the real-time log session window should display. Select the amount of
time to display on the x-axis of the graphs using the *X-axis range* drop-down
list.
3.5 Graph

The Graph tab displays options and settings related to real-time log session graphs and logged data graphs.

![Graph Tab Image](image)

**Figure 18** LogWare III Options - Graph Tab

**Note:** Changing most of these settings only affects graphs that are created and displayed after closing the LogWare III Options dialog! Graphs that are already displayed are not affected.

The Temperature graph settings indicate settings that are used for graphs that are plotting temperature readings. The Humidity graph settings indicate settings that are used for graphs that are plotting humidity readings. The Title and Y-axis title fields determine the default text that is displayed on the graphs. The title is displayed at the very top of the graph. The y-axis title is displayed on the left y-axis of the graph.

The Combined graph title field determines the text that is displayed as the title of graphs that plot both temperature and humidity readings. When both temperature and humidity readings are being plotted on the same graph, the left y-axis...
title uses the Y-axis title field below the Temperature graph heading and the right y-axis title uses the Y-axis title field below the Humidity graph heading.

The X-axis title (both graphs) field determines the text that is displayed below the x-axis of all graphs.

The Graph annotation colors list indicates the colors that are used when graph annotations are displayed on any graph. LogWare supports three types of graph annotations: Selected point, User annotation, and Invalid CRC. To select the color to use for an annotation type, double-click the item in the list. The Color dialog is displayed. Choose the color to use for the selected annotation.

Click the Select Trace Colors button to define the default colors that are used for graph traces. Refer to Section 3.5.1, Trace Colors, for more details on selecting trace colors.

The Synchronize graph zooming option determines whether zooming in on a section of a temperature graph causes the humidity graph to zoom in to the same section or vice versa. This setting is only applicable to graphs located in the same logged data window when temperature and humidity readings are plotted on separate graphs.

\textit{Note:} Real-time log session graphs do not support zooming.
3.5.1 **Trace Colors**

The Trace Colors dialog indicates the colors that should be used on the graphs for temperature and humidity traces.

![Trace Colors](image)

*Figure 20  Trace Colors*

The *Temperature sensors* and *Humidity sensors* lists indicate the color to be used for each temperature and humidity trace on the graph in the order that they will be used. Colors are used to help distinguish which graph trace corresponds to which sensor.

**Info:** The labels *Sensor n* in each list are not related to sensor models, serial numbers, or locations. They simply refer to the graph trace for the first sensor, second sensor, etc.

To select the color to use for a temperature or humidity trace, double-click the item in the appropriate list. The Color dialog is displayed. Choose the color to use for the selected graph trace.
4 Real-Time Data Logging

The primary method of logging data into the database is real-time data logging. Real-time data logging requires that a logger be connected to the computer. This allows LogWare to communicate with the logger, to configure various settings and to query the temperature and humidity measurements.

Since LogWare currently only supports communicating with a logger using RS-232 (serial) communications, LogWare can only communicate with one logger at a time. When a real-time log session is running, you should not attempt to communicate with the logger using any other tools (i.e. downloading data, etc).

**Warning:** As a general rule, if you use LogWare to log data in real-time from a logger over a period of time, you should not attempt to import or download readings from the same logger that overlap that time period. Although LogWare makes every attempt to prevent duplicate readings from being written to the database, it is impossible to guarantee that this can not happen due to issues such as PC/logger clock synchronization, real-time vs. data storage sample rates, etc. Therefore, you should **never** mix logging data in real-time and importing or downloading data from a logger for the same time period.

LogWare’s real-time data logging feature is very flexible and can be configured in many ways. Listed below are just a few examples of how LogWare could be configured:

- Log temperature data in Celsius or Fahrenheit
- Log temperature data only, humidity data only, or both simultaneously
- Log data from one or both sensors simultaneously
- Log temperature data from one sensor and humidity data from another sensor
- Log data at virtually any rate from 1 second to 24 hours
- Stagger logging data from each sensor from 1 minute to 24 hours
- Start a log session immediately or at any future date and time
- Allow a log session to run indefinitely, or automatically terminate a log session after a certain number of readings have been logged, or after a specific amount of time has elapsed
- Automatically start logging data when you login to LogWare
• Setup alarms with related alarm events to perform a certain task if an alarm value is exceeded

To configure a real-time log session, select the New Log Session option from the File menu, or select the Setup option from the Datalog menu.

4.1 Configuring a Real-Time Log Session

The Real-Time Log Session Settings dialog allows the user to configure a real-time log session.

Real-time log session settings can be saved to a configuration file and opened using this dialog. If you frequently want to use the same alarm settings, logging interval, and end log session settings to log real-time data, configure the session and save it to a log session settings (.LSS file) file by clicking the Save As button. The next time you need to start a log session, simply open the appropriate configuration file by clicking the Open button.
**Info:** Before opening a log session settings file, the logger’s current settings must be queried. A message is displayed when the Open button is clicked if the logger has not been queried yet.

The Real-Time Log Session Settings dialog has two tabs: **Logger** and **Session**.

**Note:** Before configuring a real-time log session, familiarize yourself with the options on the Real-Time tab of the LogWare III Options dialog. Refer to Section 3, LogWare III Options, for more information.

### 4.1.1 Logger Settings

The **Logger** tab allows the real-time log session settings regarding the logger and sensors to be configured.

![Figure 22 Real-Time Log Session Settings - Logger Tab](image)

When this dialog is displayed, all fields on this tab are disabled except the **Query Logger** button.
**Note:** Before proceeding, make sure the logger to use is connected to the appropriate communications port on the computer. The logger must also be turned on and running.

The first step to configuring a real-time log session is to query the current settings from the logger that will be used. Click the *Query Logger* button. LogWare attempts to communicate with the logger, reads in the current logger settings, and fills in the fields on this tab.

**Info:** LogWare keeps track of all of the loggers, sensors, and locations used to log data to the database. The first time a logger, sensor, or location is used, LogWare creates records in the database for each item. Administrators can configure LogWare to prevent certain loggers, sensors, and locations from being used to log data. Every time a logger is queried, LogWare checks to make sure the logger, sensors, and locations are active and can be used. Refer to Section 2.3, Managing Equipment, for more information on managing loggers, sensors, and locations.

The *Logger* field indicates the model and serial number of the logger being used. This information cannot be changed.

The *Temperature scale* field indicates the current temperature scale setting of the logger. If you wish to log data in a different scale, use the drop-down list to choose the scale to use.

The *Sensors* list indicates the model, serial number, and state of the sensors connected to the logger. The check box next to each sensor in this list indicates whether any data should be logged from the sensor. Unchecking the check box next to a sensor indicates LogWare should not log any data from that sensor. If the box is checked, temperature and/or humidity data will be logged, depending on the *Temperature* and *Humidity* options. Use the Enable All and Disable All buttons below the list to enable or disable all sensors.

To change the settings for a sensor, select the sensor in the *Sensors* list. The other fields on this tab are filled with the current settings for the selected sensor.

The *Sensor* field indicates the sensor model and serial number of the currently selected sensor. This information cannot be changed.

The *Location* field indicates the location of the selected sensor. This corresponds to the sensor ID in the logger. When logging data, it is important to know not only what sensor logged the data, but where the sensor was located when the data was logged (i.e. LABORATORY, MYDESK, OFFICE, CHAMBER, etc). Use this field to indicate where the selected sensor is located. Use the drop-down list to select an existing location, or add a new location by clicking the + button.
Note: You should avoid setting more than one sensor to the same location during a real-time log session. Setting more than one sensor to the same location makes it difficult to view the data by location after it is logged to the database. Instead, create a new location with a similar, but unique, name (i.e. LABORATORY1 and LABORATORY2).

The Alias field is used by LogWare to identify each sensor. This is the information that is displayed in the grid on the Real-Time Log Session window for each sensor. By default, the alias of a sensor matches the location. The alias can be changed as desired. The alias setting is not logged to the database and is discarded as soon as the log session stops.

The Temperature and Humidity options determine whether temperature and humidity readings for the selected sensor should be logged. To log both temperature and humidity, check both options. To log only temperature, check only the Temperature option. To log only humidity, check only the Humidity option. If both options are unchecked, the check box in the Sensors list is automatically unchecked, indicating no data from the selected sensor should be logged.

The three buttons next to the Temperature and Humidity options allow alarm settings, statistics, and the trace color to be configured. These buttons are disabled if the Temperature or Humidity option is not checked. The vertical bar to the right of the buttons indicates the current trace color.

To configure the alarm settings, click the button. Refer to Section 4.1.4, Alarm Settings, for more information.

To configure the statistics, click the button. Refer to Section 4.1.5, Statistics Settings, for more information.

To configure the trace color, click the button. Refer to Section 4.1.6, Color, for more information.
4.1.2 Session Settings

The Session tab allows the user to define when the log session should start, end, and the rate at which readings are logged to the database.

![Image of Session Tab settings](image)

**Figure 23** Real-Time Log Session Settings - Session Tab

The Logging interval fields determine the rate at which measurements are queried from the logger during the real-time log session. LogWare is capable of logging data at intervals from once every second to once every 24 hours.

**Info:** The exact interval between measurements on a particular channel depends on the Sample all sensors simultaneously option on the Real-Time tab of the LogWare III Options dialog. Refer to Section 3, LogWare III Options, for more information. If this option is checked, LogWare attempts to query measurements on all enabled channels at the interval indicated by the Logging interval fields (simultaneous mode). If this option is not checked, LogWare queries the measurements on only one channel at a time at the indicated interval (sequential mode).
The *Interval between scan sequences* option is only displayed if LogWare is configured for sequential mode. If this option is enabled, LogWare will query measurements on each enabled channel, one at a time at the interval indicated in the *Logging interval* fields. The LogWare will wait until the amount of time specified in the *Interval between scan sequences* fields has elapsed since the measurement process began and query measurements on each enabled channel again.

By default, LogWare expects to start logging real-time data as soon as you click the *Start* button. The *Start log session* option can be used to force LogWare to wait until a specific date and/or time to begin logging. Select whether you want the log session to begin immediately or at a specified date and time using the drop-down list.

The *Delayed start date* and *Delayed start time* settings determine when the log session should begin if the *At date and time specified below* option is selected. Use the calendar to select the date, and enter the time in the field provided. These settings are disabled if a log session is set to begin immediately.

The *End log session* option can be used to automatically stop the logging process after a specified time has elapsed or after a specific number of readings have been logged on each channel. Use the drop-down list to select the appropriate option, then set the criteria using the *End log criteria* fields. By default, log sessions continue until they are manually stopped by the user.

Once the logger and session settings are complete, start the log session by clicking the *Start* button.

### 4.1.3 Log Session Settings File

It is common to need to use the same real-time log session settings over and over again. To save time configuring a log session, LogWare allows the real-time log session settings to be saved to a configuration file, called a log session settings (.LSS file) file. Log session settings files can only be saved and opened from the Real-Time Log Session Settings dialog.

A log session settings file contains information about the temperature scale, session interval, session start, and session end settings, and sensor settings including the readings to log, alias, and statistics and alarm settings for each sensor.

A log session settings file is independent of the logger and sensors being used to log data. For this reason, the logger must be queried before a log session settings file can be opened.

A log session settings file can be opened automatically when LogWare runs. LogWare can also be configured to automatically start a log session without user interaction after logging into the database. These settings are available on
4.1.4 Alarm Settings

The Alarm Settings dialog allows low and high alarms to be configured.

![Temperature Alarm Settings](image)

The Alarm Settings dialog has two tabs: Low alarm settings and High alarm settings. Both tabs display an identical set of fields that can be used to indicate low and high alarm settings.

If the same alarm settings need to be used repeatedly, you may want to save the alarm settings to a configuration file. After configuring the settings, click the Save As button to save the alarm settings to an alarm configuration file (.ALM file). To open an alarm configuration file, click the Open button and select the configuration file to open.

The Enable low alarm or Enable high alarm option indicates whether the low and high alarms are enabled. Check this option to enable the alarm, or uncheck it to disable the alarm.

The Threshold value field indicates the low or high alarm value. Enter the value to use for the low or high alarm. The defined alarm even will be triggered if a reading is equal to or exceeds the threshold value.

The Alarm event field indicates the event that should occur if the alarm threshold value is met or exceeded. The supported alarm events include:
• No event - No further action is taken
• System beep - Causes the default operating system beep to sound
• Display message - Displays a modal message (logging stops - user must respond to continue logging)
• Play .WAV file - Causes the indicated .WAV file to play
• Launch .EXE file - Launches the indicated .EXE file

If the Display message option is selected, enter the message to display in the Message to display field. To test the message, click the “>” button to the right of the field.

If either the Play .WAV file or Launch .EXE file option is selected, click the ... (Browse) button to the right of the Filename field to locate the .WAV or .EXE file. To test the event, click the “>” button to play the .WAV file or launch the .EXE file to make sure the selected file can be played or launched.

Info: LogWare ships with a few sample .WAV files that can be used. These files are installed in the \Media subfolder. The Launch .EXE file option can be used to launch any application such as pager software which could be configured to dial a phone number automatically and transmit a fixed message to a pager indicating that an alarm has tripped.

The Event occurances field indicates how often the alarm event should occur. The supported settings are:

• Only once when alarm value is exceeded
• After every update

Select the Only once when the alarm value is exceeded option to only allow the event to occur on the first reading that trips the alarm. Subsequent readings that also exceed the alarm threshold value will not cause the event to occur again until one or more readings are taken that reset the alarm.

Select the After every update option to allow the event to happen for every reading that trips the alarm and all subsequent readings that exceed the alarm threshold value.

Info: The After every update option cannot be selected if the alarm event is set to Launch .EXE file.
4.1.5 **Statistics Settings**

The Statistics Settings dialog allows the statistical calculations displayed to be defined.

The Statistics Settings dialog has two tabs: *General* and *Sliding Window*.

**General**

The *General* tab indicates the general statistical calculations to display.

Check the options that should be displayed. Uncheck the options that should not be displayed.
Sliding Window

The Sliding Window tab indicates whether the statistics are calculated from all readings or only the most recent readings.

To enable the sliding window, check the Enable Sliding Window option and enter the number of readings to include in the sliding window. Only the most recent \( n \) readings will be used to calculate the statistical values displayed.

4.1.6 Color

The Color dialog can be used to select the graph trace colors.
Use the controls on this dialog to select the color to use or to define custom colors.

Click the OK button after choosing the color to use.

4.2 Real-Time Log Session

The Real-Time Log Session window is displayed when a real-time log session is started. The window displays the most recent measurements from each sensor in a spreadsheet style grid, graphs of the measurements of all sensors, and also displays statistical calculations and the alarm settings for the selected sensor.

When starting a log session, LogWare configures the logger according to the log session settings, including temperature scale, location (sensor IDs), alarm settings, resolutions, and sample rate.

If the log session was configured for a delayed start date/time, and the config-
ured date/time has already passed, the Select Delayed Start Date/Time dialog is displayed. Select a new start date/time and click OK to continue.

![Select Delayed Start Date/Time](image)

**Figure 30  Select Delayed Start Date/Time**

If the *Prompt to manually synchronize log session* option on the Real-Time tab of the LogWare III Options dialog is checked, a prompt is displayed as soon as the log session is ready to begin logging data. Click the OK button to begin logging data. Refer to Section 3, LogWare III Options, for more information.

To stop a log session, select the *Stop* option in the Datalog menu. The log session window can be closed by selecting the *Close* option in the Datalog menu.

The Log Session window is divided into three main sections: the sensors grid, graphs, and statistics and alarms panel. These sections can be resized by dragging the bars that divide the sections.

Each sensor is listed in order in the sensors grid. The alias defined for each sensor on the Logger tab of the Real-Time Log Session Settings dialog identifies each sensor. This grid displays the date and time the last measurement was taken, the measurement values, current alarm state, and whether the trace for each sensor is currently displayed on the graph.

Temperature and humidity readings and their alarm states are highlighted in the same colors as the graph traces defined for each sensor. If a current measured value exceeds an alarm value, the appropriate alarm state column for that sensor is highlighted in the grid in the defined color.

Individual traces on the graph can be shown or hidden by simply double-clicking on the appropriate row in the grid, or by right-clicking on the grid and se-
lecting the *Show Trace on Graph* option in the popup menu. The *Graph* column indicates whether the traces for a sensor are currently shown on the graph.

Graph trace colors for the selected sensor can also be changed by right-clicking on the grid and selecting the appropriate option from the popup menu.

As measurements are logged, they are also plotted on the graphs. Temperature and humidity readings may be plotted on the same graph, or on separate graphs. Refer to Section 3, LogWare III Options, for more information.

Graphs can be printed by selecting the *Print* option in the *File* menu or by selecting the *Print Graph* option in the *Graph* menu. If the temperature and humidity readings are displayed in separate graphs, the Select Graph To Print dialog is displayed. Select the graph(s) to print, then click the *OK* button to print the graph(s).

The graphs can also be configured to show alarm lines and data point markers by selecting the appropriate options from the *Graph* menu.

The right side of the window shows the statistical calculations for the selected sensor. Optionally, the alarm values may also be displayed in this list. If the currently selected sensor’s current measurement exceeds an alarm value, the alarm in this list is highlighted in a bold typeface. Statistics and alarms are also displayed in the defined colors for the selected sensor’s graph traces.
The statistical values displayed can be changed by right-clicking on the Statistics node in the list. The Statistics popup menu is displayed.

![Statistics menu]

Select the Statistics Settings option to change which statistical values are displayed. Select the Reset Statistics option to reset only the selected statistics. To reset all statistics for the selected sensor, select the Reset Sensor Statistics option. To reset the statistics for all sensors simultaneously, select the Reset All Statistics option.

Alarm settings can also be changed for the selected sensor during a real-time log session. To change the current alarm settings, right-click on the appropriate Alarms node in the list. The Alarms popup menu is displayed.

![Alarm settings]

Select the Alarm Settings option to change the current alarm settings.

**Note:** Changing the alarm settings during a real-time log session does **NOT** update the alarm settings in the logger!
5 Importing Data

LogWare provides a tool that allows data to be imported from files into the LogWare database. This tool can be useful when your logger is not located near a computer, or when you have multiple loggers in various locations.

Importing is only one way to get data into LogWare’s database. Data can also be downloaded directly from a logger or logged in real-time.

Importing can be an effective method to getting data into the database because it does not require a computer to be running and connected to the logger at all times like real-time logging, and it does not require taking a computer to the logger like downloading requires. It does, however, require the use of a PC card to transport the data from the logger to the computer.

To import data from a PC card, select the Import option from the File menu.

5.1 Import Options

The Import Options dialog allows the user to select one or more files to import data from.

Figure 32 Import Options
The *Import from* field indicates the location (drive letter or folder) where the import files are located. This field defaults to the \Import folder. Use the drop-down list to select the drive or folder where the files to import are located. A list of folders and files found in the selected drive or folder are displayed in the list below. To open a subfolder, double-click the appropriate folder item in the list.

Valid logger files have a .REC extension. Only files with this extension can be imported into LogWare’s database! LogWare analyzes each file before it is displayed in the list and displays information about the contents of each file in the *Contents* column. If LogWare is unable to open a file, or if the file does not match the expected format, the marker *<unknown format>* appears in the *Contents* column.

The *Preview imported data before committing to database* option allows the data to be viewed before LogWare actually writes it permanently to the database. This allows you to review the data before deciding if it should be written to the database or not. Leaving this option unchecked indicates that the data should be written to the database unconditionally.

Select the files to import by clicking on the filenames in the list. Hold down the Shift or Ctrl keys to select multiple files.

Click the *Import* button to begin the import process. The status bar at the bottom of the Import Options dialog indicates the import progress. When importing is complete, the data will either be written to the database, or displayed in the Imported Data window. Refer to Section 5.2, Imported Data, for more information.

**Note:** LogWare is designed to prevent multiple copies of the same data in the database. If you attempt to commit new data to the database, and matching data already exists in the database, the new data will simply be ignored.
5.2 Imported Data

The Imported Data window displays data that has been imported from a file or downloaded from a logger’s memory but has not yet been written (committed) to the database.

### Table: Imported Data

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Logger Model</th>
<th>Logger Serial</th>
<th>Location</th>
<th>Temperature (°C)</th>
<th>Min (°C)</th>
<th>Max (°C)</th>
<th>Humidity (%RH)</th>
<th>Min (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/02/2003  11:54:50 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.3</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:00 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:10 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:20 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:30 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:40 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:55:50 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:00 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:10 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:20 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:30 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:40 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:56:50 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:00 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:10 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.19</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:20 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:30 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:40 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:57:50 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>09/02/2003  11:58:00 PM</td>
<td>1620</td>
<td>A38000</td>
<td>LABORATORY</td>
<td>26.18</td>
<td>22</td>
<td>26</td>
<td>37.2</td>
<td>35</td>
<td></td>
</tr>
</tbody>
</table>

Total of 3640 records

### Figure 33: Imported Data

**Info:** Data columns in the grid can be resized as desired. The data columns can be reordered by dragging the column header to its new position. The data can also be sorted by simply clicking on a column header. These features are provided as a convenience only and do not have any affect on how the data is written to the database.

The data is displayed in a spreadsheet style grid. You can use the scroll bars to scroll through the data to review it before deciding whether or not to commit the data to the database.

The data displayed consists of the date and time the readings were logged, the model and serial number of the logger and the sensor that were used to log the data, the location, the temperature and humidity readings, the temperature and humidity alarm settings (Min and Max columns), and the user that imported or
downloaded the data. The total number of records is displayed at the bottom of the window.

If you decide to write (commit) the data to the database, click the Commit button. To discard the data without writing it to the database, simply close the window. A prompt is displayed to confirm discarding the data to prevent accidentally closing the window without the opportunity to commit the data to the database.

**Note:** Committing large amounts of data to the database can take many minutes. Once the Commit button has been clicked, allow sufficient time for LogWare to successfully commit the data to the database.
6 Downloading Data

LogWare provides a tool that allows data to be downloaded from the memory of a logger into the LogWare database. This tool can be useful when your logger is located near a computer.

Downloading is only one way to get data into LogWare’s database. Data can also be imported from log files or logged in real-time.

**Warning:** As a general rule, if you use LogWare to log data in real-time from a logger over a period of time, you should not attempt to import or download readings from the same logger that overlap that time period. Although LogWare makes every attempt to prevent duplicate readings from being written to the database, it is impossible to guarantee that this can not happen due to issues such as PC/logger clock synchronization, real-time vs. data storage sample rates, etc. Therefore, you should never mix logging data in real-time and importing or downloading data from a logger for the same time period.

Downloading can be an effective method to getting data into the database because it does not require a computer to be running and connected to the logger at all times like real-time logging, and it does not require using a PC card to transport data from the logger like importing. It does, however, require that the logger be located near the computer (within about 50 feet) or that the computer be taken to where the logger is located. For this reason, it is most useful to use this feature with a laptop computer.

When data is downloaded from a logger, it is actually written to a file, and then imported into LogWare in exactly the same manner as if you were importing data from a PC card file.

To download data from the memory of a logger, select the Download option from the Tools menu.
6.1 Download Options

The Download Options dialog allows the user to specify the readings to be downloaded from a logger’s memory.

When selecting the data to download from a logger’s memory, there are two options to choose from: Download all readings and Download only readings in selected date/time range.

The Download all readings option indicates that all readings currently stored in the logger’s memory should be downloaded. Use this option if data has never been downloaded from a logger before, or if the logger’s memory had been cleared since the last download.

The Download only readings in selected date/time range option allows the user to select a specific range of readings to download. When this option is selected, the date and time fields can be used to select the range or readings to download. Use this option if data has been previously downloaded from the logger’s memory, or if you are only interested in data from a specific time span.

The Date range fields are used to specify the from date and to date of the readings to download. Setting these dates to the same date causes all of the data from that day to be downloaded.
The *Time range* fields can be used to narrow down the range of the data to download even more. To specify a time range, check the *Time range* option, then select or enter the *from* time and the *to* time in the appropriate fields.

**Info:** Because the logger stores data in its memory in a highly compressed format, it may be necessary for LogWare to actually download more data than indicated by the selected date and time range settings. However, LogWare discards readings that fall outside the specified range after the data is downloaded.

The *Preview downloaded data before committing to database* option allows the data to be viewed before LogWare actually writes it permanently to the database. This allows you to review the data before deciding if it should be written to the database or not. Leaving this option unchecked indicates that the data should be written to the database unconditionally.

When the options are set appropriately, click the *Download* button to begin the download process. The logger must be connected to the computer according to the selected communication method and settings. Refer to Section 3, LogWare III Options, for more information on communication settings.

**Note:** Downloading large amounts of data can take many minutes to download. For best results, use the fastest communication setting available.

The status bar at the bottom of the Download Options dialog indicates the download progress. When downloading is complete, the data will either be written to the database, or displayed in the Imported Data window. Refer to Section 5.2, Imported Data, for more information on viewing the data and committing the data to the database.

**Note:** LogWare is designed to prevent multiple copies of the same data in the database. If you attempt to commit new data to the database, and matching data already exists in the database, the new data will simply be ignored.
7 Managing Logged Data

Once data has been logged to the database, whether logged in real-time, imported from a file, or downloaded from the logger’s memory, the data can be viewed, printed, or exported.

7.1 Viewing Logged Data

LogWare has a feature that allows data that has been logged to the database to be viewed on screen in a spreadsheet style grid and graphed. Statistics are also calculated for the data.

When viewing the data, the graphs can be zoomed, annotations can be added to individual data points, and the data and graphs can be printed or exported.

To view logged data, select the **Logged Data** option from the **View** menu.

7.1.1 View Logged Data Options

The View Logged Data Options dialog allows the user to choose the data to view and determine how it should be displayed.

![View Logged Data Options](image)

**Figure 35** View Logged Data Options

The View Logged Data Options dialog has two tabs: **Criteria** and **Misc. Settings**.
When all settings have been selected, click the OK button to view the selected data. The data is displayed in the Logged Data window. Refer to Section 7.1.2, Logged Data, for more information.

### 7.1.1.1 Criteria

The *Criteria* tab allows the data to be viewed to be selected.

![View Logged Data Options - Criteria Tab](image)

When readings are logged to the database, information about the logger and sensor that were used to log the data, as well as the location and user name are recorded with every reading. To view readings in the database, you must indicate which readings you want to view. Readings can be selected in one of two ways: by location or by sensor. Use the *Select data for* field to choose how you want to locate the readings to view.

The *Matching* field contains a list of all sensors or locations that have been used to log readings to the database. Use the drop-down list to select the location or sensor that matches the readings you want to view.

The *Date range* fields are used to specify the *from* date and *to* date of the readings to view. If you want to view all readings in the database from a particular location or sensor, leave the *Date range* option unchecked. Otherwise, check this option and select the *from* date and the *to* date. Setting these dates to the same date selects all of the readings from the selected location or sensor for that day to be viewed.

The *Time range* fields can be used to narrow down the range of the readings to view even more. To specify a time range, check the *Time range* option, then select or enter the *from* time and the *to* time in the appropriate fields.
Optionally, click the Test Query button to query the database and find out how many readings match the criteria you selected. A message appears indicating the number of records found in the database that match the criteria.

Note: LogWare is designed to handle large amounts of data (hundreds of thousands of readings) from a single query. However, be aware that viewing such large sets of data may take a few minutes. Some older, slower computers may not be able to display large amounts of data in a reasonable amount of time. You may wish to break up the data into smaller chunks to be more efficient.

7.1.1.2 Misc Settings

The Misc. Settings tab includes various options for determining how the data should be viewed.

The Temperature readings and Humidity readings options allow the user to specify which readings should be viewed. Check each applicable option.

The Plot temperature and humidity readings on same graph option determines whether separate graphs are created in the Logged Data window for temperature and humidity readings, or whether temperature and humidity readings are plotted on the same graph. When plotting temperature and humidity readings on the same graph, temperature readings use the left y-axis and humidity readings use the right y-axis of the graph.
Select the temperature scale to use to display the data using the *Select temperature scale* drop-down list. Temperature readings are always stored in the database in Celsius. LogWare converts the readings to the desired scale for viewing.

The *Reading resolutions* fields indicate the number of decimal places to use to format the data. All readings are logged to the database according to the resolution settings that were used at the time the data was logged. Select the number of digits to use for temperature readings using the *Temperature* field and humidity readings using the *Humidity* field.

### 7.1.2 Logged Data

The Logged Data window displays the selected data from the database in a spreadsheet style grid, in graphs and also displays statistical calculations for the data.

The Logged Data window is divided into three main sections: the readings grid, graphs, and statistics and alarms panel. These sections can be resized by dragging the bars that divide the sections.
The individual readings of the selected data can be viewed in the spreadsheet style grid in the upper left corner of the window. Use the scroll bars to scroll through the data. The displayed data consists of the date and time the readings were logged, the temperature and humidity readings (as applicable), the temperature and humidity alarm values (as applicable) and annotations. Columns may be resized as desired. The readings are always ordered by date and time.

Temperature and humidity readings and their alarm values are highlighted in the colors defined for Sensor 1 on the Graph tab of the LogWare III Options dialog. Refer to Section 3, LogWare III Options, for more information. Temperature or humidity readings that exceed an alarm value are highlighted in the grid in the defined color.

If LogWare determines that a reading may have been modified since it was logged to the database (Invalid CRC), the entire row for that reading is highlighted in yellow.

Annotations can be added to any reading in the grid to indicate special conditions, occurrences, or events that can help identify specific points in the data by selecting the Annotations option in the Tools menu or by right-clicking on the readings grid. Refer to Section 7.1.3, Annotations, for more information on using annotations.

The data is also graphed. Temperature and humidity readings may be plotted on the same graph, or on separate graphs. You can zoom in on a small section of a graph by clicking on the graph and dragging the mouse to draw a box. When temperature and humidity readings are plotted on separate graphs, the zoom feature can be synchronized to cause both graphs to zoom to the same area.

Graphs can be printed by selecting the Print | Graph option in the File menu or by selecting the Print Graph option in the Graph menu. If the temperature and humidity readings are displayed in separate graphs, the Select Graph To Print dialog is displayed. Select the graph(s) to print, then click the OK button to print the graph(s).

![Select Graph To Print](image)

Figure 39  Select Graph To Print

The graphs can also be configured to show alarm lines, annotations, and data point markers by selecting the appropriate options from the Graph menu.
When showing annotations on the graphs, there are three types of annotations displayed: *Selected point*, *User annotation*, and *Invalid CRC*. The colors that are used to display these annotations are defined on the *Graph* tab of the LogWare III Options dialog. Refer to Section 3, LogWare III Options, for more information.

- **Selected point** annotation indicates the currently selected row in the grid and consists of a dashed vertical line and the text indicating the date and time for the reading.
- **User annotation** indicates annotations added to readings by the user and consists of a dashed vertical line and the annotation text.
- **Invalid CRC** annotation indicates readings that may have been tampered with since being logged to the database and consists of a dashed vertical line and the words, “Invalid CRC”.

The right side of the Logged Data window shows the statistical calculations for the readings displayed in this window. Optionally, the alarm values may also be displayed in this area. The statistical calculations are always for all readings displayed. The alarm values are for the currently selected reading in the grid only. If the currently selected reading exceeds an alarm value, the alarm in this list is highlighted in a bold typeface.

The statistical values displayed can be changed by right-clicking on the *Statistics* node in the list. The *Statistics* popup menu is displayed.

Select the *Statistics Settings* option to change which statistical values are displayed.

### 7.1.3 Annotations

Annotations can be added to any reading once it has been logged to the database. Annotations are very useful for making notes about special conditions, occurrences, or events that can help identify specific points in the data.

#### 7.1.3.1 Adding Annotations to Readings

To add an annotation to a reading:

1. Select the data using the *Logged Data* option in the *View* menu. The Logged Data window is displayed.
2 Scroll through the grid in the upper left section of the window to locate the data reading to annotate. Click on the row in the grid to select the point.

3 Either right-click on the grid to display the *Annotation* popup menu or select the *Annotation* option in the *Tools* menu.

4 Select the *Add Annotation* option. The Add Annotation dialog is displayed.

5 Enter the annotation text in the *Annotation* field and click *OK* to close the dialog.

![Add Annotation](image)

Figure 40 Add Annotation

### 7.1.3.2 Editing existing user annotations

To edit an existing user annotation:

1 Select the data using the *Logged Data* option in the *View* menu. The Logged Data window is displayed.
Scroll through the grid in the upper left section of the window to locate the data reading with the annotation to edit. Click on the row in the grid to select the point.

Either right-click on the grid to display the Annotation popup menu or select the Annotation option in the Tools menu.

Select the Edit Annotation option. The Edit Annotation dialog is displayed with the current annotation in the Annotation field.

Enter the new annotation text in the Annotation field and click OK to close the dialog.

To remove an existing user annotation:

1. Select the data using the Logged Data option in the View menu. The Logged Data window is displayed.
2 Scroll through the grid in the upper left section of the window to locate the data reading with the annotation to edit. Click on the row in the grid to select the point.

3 Either right-click on the grid to display the Annotation popup menu or select the Annotation option in the Tools menu.

4 Select the Remove Annotation option. A confirmation message is displayed. Click Yes to confirm removing the annotation. The annotation is removed.

7.2 Exporting Logged Data

LogWare has a feature that allows data that has been logged to the database to be exported to a variety of file formats.

To export logged data, select the Export option from the File menu. If a Logged Data window is active when you select this menu option, LogWare expects that you want to export the data in the Logged Data window. Otherwise, you need to select the data to export. LogWare displays the Export Logged Data Options dialog.
7.2.1 Export Logged Data Options

The Export Logged Data Options dialog allows the user to choose the data to export and determine how it should be exported.

The Export Logged Data Options dialog has three tabs: Export Options, Criteria and Misc. Settings. If you are exporting data from a Logged Data window, only the Export Options tab is displayed.

When all settings have been selected, click the OK button to export the selected data. The Export Filename dialog is displayed. Choose the filename and folder to write the data to and click the Save button. The default folder that the export files are written to is defined on the Folders tab of the LogWare III Options dialog. Refer to Section 3, LogWare III Options, for more information.
7.2.1.1 Export Options

The Export Options tab contains various settings regarding how the data is to be exported.

The Export file type field determines to file type that the data is exported to. LogWare can export data to one of three file types:

- **Comma-separated values** (.CSV file)
- **Rich Text Format** (.RTF file)
- **HTML document** (.HTM file)

Each of these formats can be useful for different applications. If you want to import the data into a spreadsheet, the comma-separated values format may be best. If you want to open the file in a word processor, use the rich text format option. If you want to share or e-mail the data, HTML documents are probably the best choice. Select the type of file format you want the data to be exported to using the drop-down list.

The Export statistics summary after data option determines whether the calculated statistics for the selected data are exported at the end of the file. This option is disabled if the selected file format is comma-separated values.

The Export out-of-tolerance statistics after data option determines whether the statistics regarding what percentage of the readings in this data are “out of tolerance” (exceeded the alarm values) are exported at the end of the file. This option is disabled if the selected file format is comma-separated values.
The Font name and Size (points) settings determine the font to be used to export the report. Select the font and size that best suits your needs. These fields are disabled if the selected file format is comma-separated values.

Click the Select Fields to Export button to determine the data columns, column widths, and column order to use when exporting reports. This button is disabled if the selected file format is comma-separated values. Refer to Section 7.2.1.1.1, Export Fields, for more information on configuring the fields to export.

### 7.2.1.1 Export Fields

The Export Fields dialog allows the fields to be exported to be defined.

### Figure 44 Export Fields

This dialog is used to determine which columns of data are exported, the order in which the columns are exported, and the width of each column.

Columns that are to be exported are indicated in the spreadsheet style grid with the symbol ✓. Columns that are not to be exported are indicated with the symbol ✗. To toggle the state of a column, click the column header. The symbol will change indicating the current state of the column.

To set the order to the columns to export, simply drag the column header to the new position and drop it.

To set the width of each column, use the Export column widths fields. Select the column in the list, then enter the width in the field provided. You can
change the scale using the drop-down list. Supported scales are **inches** (in) and **centimeters** (cm). When switching scales, the column widths are automatically converted to the new scale. The total combined width of all columns is indicated below the list.

*Info:* Adjusting the width of the columns in the grid does not affect the width of the columns when exported. You must use the Export column widths fields to set the column widths.

### 7.2.1.2 Criteria

The **Criteria** tab allows the data to be exported to be selected.

<table>
<thead>
<tr>
<th>Export Options</th>
<th>Criteria</th>
<th>Misc. Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select data for...</td>
<td>Matching:</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>LABORATORY</td>
<td></td>
</tr>
<tr>
<td>Date range:</td>
<td>Time range:</td>
<td>Test Query</td>
</tr>
<tr>
<td>from 09/09/2003</td>
<td>at 12:00:00 PM</td>
<td></td>
</tr>
<tr>
<td>to 09/09/2003</td>
<td>at 4:05:00 PM</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 45  Export Logged Data Options - Criteria Tab*

When readings are logged to the database, information about the logger and sensor that were used to log the data, as well as the location and user name are recorded with every reading. To export readings from the database, you must indicate which readings you want to export. Readings can be selected in one of two ways: by location or by sensor. Use the Select data for field to choose how you want to locate the readings to export.

The **Matching** field contains a list of all sensors or locations that have been used to log readings to the database. Use the drop-down list to select the location or sensor that matches the readings you want to export.

The **Date range** fields are used to specify the from date and to date of the readings to export. If you want to export all readings in the database from a particular location or sensor, leave the **Date range** option unchecked. Otherwise, check
this option and select the *from* date and the *to* date. Setting these dates to the same date selects all of the readings from the selected location or sensor for that day to be exported.

The *Time range* fields can be used to narrow down the range of the readings to view even more. To specify a time range, check the *Time range* option, then select or enter the *from* time and the *to* time in the appropriate fields.

Optionally, click the *Test Query* button to query the database and find out how many readings match the criteria you selected. A message appears indicating the number of records found in the database that match the criteria.

**Note:** *LogWare is designed to handle large amounts of data (hundreds of thousands of readings) from a single query. However, be aware that exporting such large sets of data may take a few minutes. Some older, slower computers may not be able to export large amounts of data in a reasonable amount of time. You may wish to break up the data into smaller chunks to be more efficient.*

### 7.2.1.3 Misc. Settings

The *Misc. Settings* tab includes various options for determining how the data should be exported.

![Export Logged Data Options - Misc. Settings](image)

The *Temperature readings* and *Humidity readings* options are disabled when exporting. To choose whether temperature or humidity readings print on the report, refer to Section 7.2.1.1, Export Options.
The *Plot temperature and humidity readings on same graph* option is also disabled when exporting.

Select the temperature scale to use to export the data using the *Select temperature scale* drop-down list. Temperature readings are always stored in the database in Celsius. LogWare converts the readings to the desired scale for exporting.

The *Reading resolutions* fields indicate the number of decimal places to use to format the data. All readings are logged to the database according to the resolution settings that were used at the time the data was logged. Select the number of digits to use for temperature readings using the *Temperature* field and humidity readings using the *Humidity* field.

### 7.3 Printing Reports

LogWare has a feature that allows data that has been logged to the database to be printed in tabular format to a printer. Statistics can also be calculated and printed with the data.

To print a report of logged data, select the *Print \ Report* option from the *File* menu. If a Logged Data window is active when you select this menu option, LogWare expects that you want to print the data in the Logged Data window. Otherwise, you need to select the data to print. LogWare displays the Print Logged Data Options dialog.
7.3.1 Print Logged Data Options

The Print Logged Data Options dialog allows the user to choose the data to print and determine how it should be printed.

![Print Logged Data Options](image)

Figure 47 Print Logged Data Options

The Print Logged Data Options dialog has three tabs: Print Options, Criteria and Misc. Settings. If you are printing a report of the data in a Logged Data window, only the Print Options tab is displayed.

When all settings have been selected, click the OK button to print the selected data. Figure 48 shows an example page of a printed report.
### Report for location LABORATORY on 09/09/2003...

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Temperature (°C) Min</th>
<th>Temperature (°C) Max</th>
<th>Humidity (%RH) Min</th>
<th>Humidity (%RH) Max</th>
<th>Annotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/09/2003</td>
<td>11:30:00 AM</td>
<td>24.90</td>
<td>24.00</td>
<td>35.00</td>
<td>40.00</td>
<td></td>
</tr>
<tr>
<td>09/09/2003</td>
<td>11:30:10 AM</td>
<td>24.90</td>
<td>24.00</td>
<td>35.00</td>
<td>40.00</td>
<td></td>
</tr>
<tr>
<td>09/09/2003</td>
<td>11:30:20 AM</td>
<td>24.90</td>
<td>24.00</td>
<td>35.00</td>
<td>40.00</td>
<td></td>
</tr>
<tr>
<td>09/09/2003</td>
<td>11:30:30 AM</td>
<td>24.90</td>
<td>24.00</td>
<td>35.00</td>
<td>40.00</td>
<td></td>
</tr>
<tr>
<td>09/09/2003</td>
<td>11:30:40 AM</td>
<td>24.90</td>
<td>24.00</td>
<td>35.00</td>
<td>40.00</td>
<td></td>
</tr>
</tbody>
</table>

### Figure 48  Sample of Printed Report

Page 70 of 71  09/23/2003 1:20:48 PM
7.3.1.1 Print Options

The Print Options tab contains various settings regarding how the data is to be printed.

- **Select printer before printing report**: Determines whether the Print dialog is displayed before the report is printed to allow the printer to which the report is printed to be selected. Unchecking this option causes the report to be printed to the default printer.
- **Preview report before printing**: Determines whether the report is displayed on screen in a Preview window instead of being sent to the printer. Reports can be printed from the Preview window. Refer to Section 7.4, Print Preview, for more information.
- **Print statistics summary at end of report**: Determines whether the calculated statistics for the selected data are printed at the end of the report.
- **Print out-of-tolerance statistics at end of report**: Determines whether the statistics regarding what percentage of the readings in this report are “out of tolerance” (exceeded the alarm values) are printed at the end of the report.
- **Paper orientation options**: Portrait and Landscape, determine the paper orientation to use when printing the report.
- **Font name and Size (points)** settings determine the font to be used to print the report. Select the font and size that best suits your needs.

![Print Options Tab](image-url)
Click the Select Fields to Print button to determine the data columns, column widths, and column order to use when printing reports. Refer to Section 7.3.1.1.1, Print Fields, for more information on configuring the fields to print.

7.3.1.1.1 Print Fields

The Print Fields dialog allows the fields to be printed on a report to be defined.

This dialog is used to determine which columns of data print on reports, the order in which the columns are printed, and the width of each column.

Columns that are to be printed on the report are indicated in the spreadsheet style grid with the symbol ☑️. Columns that are not to be printed on the report are indicated with the symbol ☐️. To toggle the state of a column, click the column header. The symbol will change indicating the current state of the column.

To set the order to the columns to print, simply drag the column header to the new position and drop it.

To set the printed width of each column, use the Print column widths fields. Select the column in the list, then enter the width in the field provided. You can change the scale using the drop-down list. Supported scales are inches (in) and centimeters (cm). When switching scales, the column widths are automatically converted to the new scale. The total combined width of all columns is indicated below the list.
**Info:** Adjusting the width of the columns in the grid does not affect the printed width of the columns on the report. You must use the Print column widths fields to set the column widths.

### 7.3.1.2 Criteria

The *Criteria* tab allows the data to be printed to be selected.

![Print Logged Data Options - Criteria Tab](image)

---

When readings are logged to the database, information about the logger and sensor that were used to log the data, as well as the location and user name are recorded with every reading. To print a report of readings from the database, you must indicate which readings you want to print in the report. Readings can be selected in one of two ways: by location or by sensor. Use the *Select data for* field to choose how you want to locate the readings to print.

The *Matching* field contains a list of all sensors or locations that have been used to log readings to the database. Use the drop-down list to select the location or sensor that matches the readings you want to print.

The *Date range* fields are used to specify the *from* date and *to* date of the readings to print. If you want to print all readings in the database from a particular location or sensor, leave the *Date range* option unchecked. Otherwise, check this option and select the *from* date and the *to* date. Setting these dates to the same date selects all of the readings from the selected location or sensor for that day to be printed.

The *Time range* fields can be used to narrow down the range of the readings to view even more. To specify a time range, check the *Time range* option, then select or enter the *from* time and the *to* time in the appropriate fields.
Optionally, click the Test Query button to query the database and find out how many readings match the criteria you selected. A message appears indicating the number of records found in the database that match the criteria.

**Note:** LogWare is designed to handle large amounts of data (hundreds of thousands of readings) from a single query. However, be aware that printing such large sets of data may take a few minutes. Some older, slower computers may not be able to print large amounts of data in a reasonable amount of time. You may wish to break up the data into smaller chunks to be more efficient.

### 7.3.1.3 Misc Settings

The Misc. Settings tab includes various options for determining how the data should be printed.

The Temperature readings and Humidity readings options are disabled when printing reports. To choose whether temperature or humidity readings print on the report, refer to Section 7.3.1.1.1, Print Fields.

The Plot temperature and humidity readings on same graph option is also disabled when printing reports.

Select the temperature scale to use to display the data using the Select temperature scale drop-down list. Temperature readings are always stored in the database in Celsius. LogWare converts the readings to the desired scale for printing.
The *Reading resolutions* fields indicate the number of decimal places to use to format the data. All readings are logged to the database according to the resolution settings that were used at the time the data was logged. Select the number of digits to use for temperature readings using the *Temperature* field and humidity readings using the *Humidity* field.

### 7.4 Print Preview

The Print Preview window is used to view reports on screen without having to print a hard copy.

The Print Preview window toolbar provides buttons to close the Print Preview window, open and save reports to files, open the help file, navigate through all of the pages of the report, zoom in and out, and print the report.
Reports can be saved to a report file (.RPT file). However, these files have a proprietary format and cannot be opened or viewed by other applications. Report files can only be opened and printed from the Print Preview window itself. If you need to share a report with others in a standard file format such as HTML or RTF, use LogWare’s Export feature to export the data to a standard format file. Refer to Section 7.2, Exporting Logged Data, for more information.
8 Database Maintenance

It is important to regularly backup and maintain your database to prevent problems from arising.

As you add records to and remove records from the database, its size can grow rapidly. Also, the potential for problems to arise in the database can increase. LogWare’s database is limited to a maximum size of 2GB.

As a result, the database should be compacted as a routine maintenance process approximately once a month or as deemed necessary. LogWare provides a tool for compacting the database.

8.1 Compacting the Database

To compact the database:

1. Run LogWare and login using an administrator account.
2. Select the Database \ Compact Database option in the Tools menu.
3. The database is compacted.
4. After the process is complete, you are prompted to login to the database again.

The LogWare database is named LOGWARE3.MDB and is located in the \Database folder. As part of the process of compacting the database, a copy is made of the current database before the compacting process begins. This copy is given the name LOGWARE3.mnn where mnn is a sequential number starting at 000. These copies of the database can be left as is, however, it is recommended that you either move these files to another disk drive or even burn them to a CD as they can take a lot of disk space.
9 Technical Support

Technical support can be obtained by calling, e-mailing or faxing Hart Scientific Technical Support:

- Phone: (801) 763-1600
- Toll Free: 1-800-GET-HART (1-800-438-4278)
- Fax: (801) 763-1010
- E-mail: support@hartscientific.com
- Internet: www.hartscientific.com

Check our website on the Internet regularly for answers to Frequently Asked Questions, software updates, and Service Releases.

Before contacting Technical Support, check the links below to see if the problem you are having can be resolved by information contained in these sections:

- Section 1.5, Requirements
- Section 1.6, Installation
- Section 1.7, Running LogWare
- Section 8, Database Maintenance
- Section 2, Security
- Section 2.1, Administration
- Section 2.2, User Accounts

When calling or sending a fax, please send or have the following information ready:

- Name of the software (LogWare III)
- Software version (as found on the Help | About dialog)
- Detailed description of the problem
- What the software was doing when the problem arose
- The exact wording and/or number of any error message received
- Any other information that may help to solve the problem
Index

! .ALM file 35,50 .CSV file 77 .EXE file 51 .HTM file 77 .LSS file 35,44,49 .REC file 60 .RPT file 89 .RTF file 77 .WAV file 51

A access level 7,11,18,20 - 21,30 active 20,28 - 30,46 add account 19 add annotation 14,72 add location 30 - 31 administrator account 7,17 - 20,23,91 Administrator rights 5 alarm events 10,12,44,50 - 51 alarm settings 35,39,44,47,49 - 50,54,57 alarms 9,11,13,44,56,71 - 72 alias 47,49,55 annotations 9,11,13 - 14,41,67,71 - 72 arrange 15

B baud rate 4,37 built-in administrator account 7,18

C cascade 15 change password 23,25 clock 11 color 41 - 42,54 column width 78,85 COM port 4,37 comma-separated values 77 commit 60 - 61,65 communications 36 - 37,43 compact database 14,91 configuration file 8,34 - 35,44,49 - 50 conventions 1 create account 19,26 create password 22

D data points 9,11,13,56,67,71 database 14 Datalog menu 12 date 11,55,61,64,68,79,86 decimal places 39,81,88 default configuration file 34 - 35 default settings 11,14,18,33 delayed start 43,49,54 download 9,11,14,18,63 - 64

E edit annotation 14,73 end log session 43,49 Excel 2 export 9 - 10,12,18,36,76 Export Fields 78
Index

F
features 2,9,17
File menu 11
folders 35,60
font name 78,84
font size 78,84

G
Graph menu 13
graph title 40
graphs 38,69,71

H
Help menu 15
high alarm 50
HTML documents 77
humidity readings 38-40,47,55,61,69,71,80,87

I
import 9 - 10,12,18,59
Imported Data 61
installation 5
interval 48
Invalid CRC 41,71 - 72
IR port 4

L
location 27,30,46,54,61,68,79,86
location name 30 - 31
logged data 9,13,18,67,70
logged data graphs 40
logger 27,43,45 - 46,61,79,86
logging interval 48
login 7,12,17 - 20,25 - 26
low alarm 50

M
main display 9
maintain database 91
manage equipment 9,11,14,27
manage user accounts 11,14,19,24
menus 9,11
model 28 - 29,46,61
modify account 20
mute alarms 9 - 10,12

N
new account 19
new location 31,46

O
on-line help file 11
options 11
orientation 84
out of tolerance 77,84
overview 2

P
password 7,17 - 18,20,22 - 23
PC card 59,63
permissions 18
preview 60,65,84,88
Print Fields 85
print graphs 9 - 10,12 - 13,56,71
Print Preview 88
print reports 9 - 10,12,81 - 82,88
R
rate 48,54
real-time log session 7,9 - 12,18,34,36,38,40,43 - 44,49,54
remarks 20,28 - 30
remove account 14,21
remove annotation 74
remove location 31
requirements 4
resolution 39,54,81,88
RS-232 4,36 - 37,43

S
scale 79,85
scan sequence 49
security 3,7,17 - 18
Selected point 41,72
sensor 27,29,45 - 46,55,61,68,79,86
sensor ID 46,54
sequential mode 39,48
serial number 5,28 - 29,46,61
simultaneous mode 39,43,48
sliding window 53
start log session 35,43,49
statistics 47,49,52,54 - 55,57,72,77,84
status bar 9,13,60,65
symbols 1
synchronize 39,41,55,71

T
Technical Support 15,93
temperature readings 38 - 40,47,55,61,69,71,80,87
temperature scale 43,46,49,54
tile 15
time 55,61,64,68,80,86
toolbar 9 - 10,13,88

Tools menu 14	race colors 41 - 42,47,53,56

U
unknown format 60
USB 4
user accounts 7,9,14,17 - 18
user annotation 41,72 - 74
user name 17 - 18,20,22,61,79,86

V
view logged data 13,67
View menu 13

W
Window menu 15
Windows 4

Z
zoom 9,11,13,41,67,71